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About this guide
This guide provides setup and troubleshooting information for the HP Z Workstation series. It includes
these topics:
Guide topics
Locating HP resources on page 1
Workstation features on page 6
Setting up the workstation on page 14
Setting up and restoring Microsoft Windows on page 26
Setting up and restoring Linux on page 28
Diagnostics and Minor Troubleshooting on page 33
Routine Care on page 39

TIP: If you do not find what you are looking for in this guide:
— Find technical details in the Manufacturing and Service Guide at http://www.hp.com/support/
workstation_manuals.
— View component installation videos at http://www.hp.com/go/sml.
— See additional information on your workstation at http://www.hp.com/go/workstations.
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Locating HP resources
This section provides information on the following HP resources for your workstation:
Topics
Product information on page 2
●

Technical specifications

●

HP Cool Tools

●

Regulatory information

●

Accessories

●

System board

●

Serial number and Certificate of Authenticity labels

Support on page 3
●

Product support

●

HP Support Assistant

●

Warranty information

Product documentation on page 4
●

HP and third-party documentation, white papers

●

Product notifications

●

Technical specifications (QuickSpecs)

●

Customer Advisories, Security Bulletins, Notices

Product diagnostics on page 4
●

Diagnostics tools

●

Audible beeps and LED code definitions

●

POST error codes

Product updates on page 5
●

Driver and BIOS updates

●

Operating systems
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Product information
Table 1-1 Product information
Topic

Location

Technical specifications

Go to www.hp.com/go/quickspecs. In the left pane, select your region and then
select Workstations.

HP Cool Tools

Most HP Microsoft Windows workstations are preloaded with tools that may enhance
system performance and with additional software that is not automatically installed
during first boot. To access these applications:
●

Click the HP Cool Tools icon on the desktop, or

●

Open the HP Cool Tools folder by selecting Start > All Programs > HP >
HP Cool Tools.

To learn more about these applications, click HP Cool Tools—Learn More.
To install or launch the applications, click the appropriate application icon.
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Regulatory information

Refer to the Safety & Regulatory Information guide for product Class information. You
can also refer to the label on the workstation chassis.

Accessories

For complete and current information on supported accessories and components, see
http://www.hp.com/go/workstations.

System board

A diagram of the system board is located on the inside of the side access panel
(tower and desktop configurations) or on the inside of the chassis (all-in-one
configurations). Additional information is located in the Maintenance and Service
Guide on the Web at http://www.hp.com/support/workstation_manuals/.

Serial number and Certificate of
Authenticity (COA) labels (if
applicable)

Serial number labels are on the top or back panel (tower and desktop configurations)
or on a pull-out card on the side of the display (all-in-one configuration). The COA
label is typically located near the serial number label. Some workstations have this
label on the bottom panel.

Linux

For information on running Linux on HP workstations, go to http://www.hp.com/
linux/, then select Linux on Workstations from the list on the left.
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Support
Table 1-2 Support
Topic
Product support

Location
For U.S. support, go to http://www.hp.com/go/contactHP.
For worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.
Here you can:

HP Support
Assistant

●

Chat online with an HP technician

●

Obtain E-mail support

●

Find support telephone numbers

●

Locate an HP service center

HP Support Assistant is an HP application that helps you maintain the performance of your workstation
and resolve problems through automated updates and tune-ups, built-in diagnostics, and guided
assistance.
To access HP Support Assistant, double-click the HP Support Assistant icon on your desktop.
NOTE: HP Support Assistant is pre-installed on all HP workstations running Microsoft Windows 7. HP
Support Assistant is not available on workstations running Linux.

Warranty
information

To locate base warranty information, see http://www.hp.com/support/warranty-lookuptool.
To locate an existing Care Pack, see http://www.hp.com/go/lookuptool.
To extend a standard product warranty, see http://h20219.www2.hp.com/services/us/en/warranty/
carepack-overview.html. HP Care Pack Services offer upgraded service levels to extend and expand a
standard product warranty.
For some countries/regions, a printed HP Limited Warranty is provided in the box. In countries/regions
where the warranty is not provided in printed format, you may request a printed copy from
www.hp.com/go/orderdocuments or write to:
●

North America: Hewlett Packard, MS POD, 11311 Chinden Blvd, Boise, ID 83714, USA

●

Europe, Middle East, Africa: Hewlett-Packard, POD, Via G. Di Vittorio, 9, 20063, Cernusco
s/Naviglio (MI), Italy

●

Asia Pacific: Hewlett-Packard, POD, P.O. Box 200, Alexandra Post Office, Singapore 911507

Please include your product number, warranty period (found on your serial number label), name and
postal address.

Support
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Product documentation
Table 1-3 Product documentation
Topic

Location

HP user documentation, white
papers, and third-party
documentation

For the latest online documentation, go tohttp://www.hp.com/support/
workstation_manuals. These include this User Guide and the Maintenance and
Service Guide.

Removal and replacement videos

To learn how to remove and replace workstation components, go to
http://www.hp.com/go/sml.

Product notifications

Subscriber's Choice is an HP program that allows you to sign up to receive driver
and software alerts, proactive change notifications (PCNs), the HP newsletter,
customer advisories, and more. Sign up at www.hp.com/united-states/subscribe/
gateway/?jumpid=go/subscribe-gate1.
Customer advisories and product change notifications are also available on
http://www.hp.com/go/bizsupport/.

Technical specifications

The Product Bulletin contains QuickSpecs for HP Workstations. QuickSpecs include
information the operating system, power supply, memory, CPU, and many other
system components. To access the QuickSpecs, see http://www.hp.com/go/
quickspecs/.

Customer Advisories, Security
Bulletins, and Notices

To find advisories, bulletins, and notices:
1.

See http://www.hp.com/go/workstationsupport.

2.

Select the desired product.

3.

From the Resources section, select See more…

4.

Use the scroll bar to select Customer Advisories, Customer Bulletins, or
Customer Notices.

Product diagnostics
Table 1-4 Product diagnostics
Topic
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Location

Diagnostics tools

The HP Vision Diagnostics utility is pre-installed on Windows 7 systems. To transfer it
to an optical disc or USB flash drive, click Start > All Programs > HP Help &
Support > HP Vision Diagnostics Disk Creation.

Audible beep and LED code
definitions

Refer to the workstation Maintenance and Service Guide at http://www.hp.com/
support/workstation_manuals.

POST error codes

Refer to the workstation Maintenance and Service Guide at http://www.hp.com/
support/workstation_manuals.
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Product updates
Table 1-5 Product updates
Topic
Driver and BIOS updates

Location
See http://www.hp.com/go/workstationsupport to verify that you have the latest
drivers for the workstation.
To determine the current workstation BIOS on your workstation, follow these steps
during system power up:
1.

Power on the workstation, and press Esc during boot up..

2.

Press F10 to enter the F10 Setup utility.

3.

Go to File > System Information. Note the BIOS version and date and
compare it with the BIOS versions that appear on the HP website.

Alternatively, on Windows 7 systems you can:,You can also find the BIOS version
under Windows 7 by going to All Programs > Accessories > System Tools > System
Information > In the right pane, find the line with "BIOS Version/Date. Note the BIOS
version and date and compare it with the versions that appear on the HP website.

Operating systems

1.

Go to Start > All Programs > Accessories > System Tools > System
Information.

2.

In the right pane, find the line with BIOS Version/Date.

3.

Note the BIOS version and date and compare it with the versions that appear
on the HP website.

For additional information, on:
●

Operating systems supported on HP workstations, go to http://www.hp.com/
go/wsos.

●

Windows operating systems, go to http://www.microsoft.com/support.

●

Linux operating systems, go to http://www.hp.com/linux.

Product updates
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Workstation features
For complete and current information on supported accessories and components for your workstation,
see http://partsurfer.hp.com.

HP Z420 Workstation components
HP Z420 Workstation front panel
Figure 2-1 Front panel components

Table 2-1 Component descriptions
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1

Optical drive

5

USB 3.0 ports (2, blue)

2

Power button

6

Headphone connector

3

Hard drive activity light

7

Microphone connector

4

USB 2.0 port (black)

8

IEEE–1394a FireWire connector

Chapter 2 Workstation features

HP Z420 Workstation rear panel
Figure 2-2 Rear panel components

Table 2-2 Component descriptions
1

Power supply Built-In Self Test
(BIST) LED

2

Universal chassis clamp opening

10

Microphone connector (pink)

3

PS/2 mouse connector (green)

11

AMT-enabled RJ-45 network
connector (orange)

4

USB 2.0 ports (4, black)

12

USB 3.0 ports (2, blue)

5

Security slot

13

IEEE-1394a FireWire connector
(white)

6

Padlock loop

14

PS/2 keyboard connector
(purple)

7

Audio line-in connector (blue)

15

Rear power button

8

Graphics card connector

16

Power cord connector

9

Audio line-out connector (green)

HP Z420 Workstation components
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HP Z620 Workstation components
HP Z620 Workstation front panel
Figure 2-3 Front panel components

Table 2-3 Component descriptions

8

1

Optical drive

5

USB 3.0 ports (2, blue)

2

Power button

6

Headphone connector

3

Hard drive activity light

7

Microphone connector

4

USB 2.0 port (black)

8

IEEE–1394a FireWire connector
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HP Z620 Workstation rear panel
Figure 2-4 Rear panel components

Table 2-4 Component descriptions
1

Power cord connector

8

Audio line-out connector (green)

2

PS/2 mouse connector (green)

9

Microphone connector (pink)

3

USB 2.0 ports (4, black)

4

RJ-45 network connectors (orange)
Bottom connector is AMT enabled

10

USB 3.0 ports (2, blue)

11

IEEE-1394a FireWire connector (white)

5

Audio line-in connector (blue)

12

PS/2 keyboard connector (purple)

6

Graphics card connector

13

Rear power button

7

Security slot

14

Power supply Built-In Self Test (BIST)
LED

HP Z620 Workstation components
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HP Z820 Workstation components
HP Z820 Workstation front panel
Figure 2-5 Front panel components

Table 2-5 Component descriptions
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1

Optical drive

5

USB 3.0 ports (2, blue)

2

Power button

6

Headphone connector

3

Hard drive activity light

7

Microphone connector

4

USB 2.0 port (black)

8

IEEE–1394a FireWire connector
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HP Z820 Workstation rear panel
Figure 2-6 Rear panel components

Table 2-6 Component descriptions
1

Power cord connector

2

3

4

9

USB 3.0 ports (2, blue)

PS/2 mouse connector (green)

10

USB 2.0 ports (4, black)

Audio line-in connector (blue)

11

Audio line-out connector (green)

12

Microphone connector (pink)

RJ-45 network connectors (2, orange)
Top connector is AMT enabled

5

IEEE-1394a FireWire connector (white)

13

PS/2 keyboard connector (purple)

6

Security slot

14

Rear power button

7

Graphics card connector(s)

15

Power supply Built-In Self Test (BIST)
LED

8

Serial connector (teal blue)

HP Z820 Workstation components

11

Product specifications
Workstation weights and dimensions
Characteristic

HP Z420 Workstation

HP Z620 Workstation

HP Z820 Workstation

Weight (standard
configuration)

13.2 kg (29.2 lb)

17.9 kg (39.4 lb)

26.6 kg (58.7 lb)

Weight (minimum
configuration)

12.5 kg (27.5 lb)

15.5 kg (34.2 lb)

24.0 kg (52.9 lb)

Weight (maximum
configuration)

17.7 kg (39.4 lb)

22.6 kg (49.9 lb)

32.0 kg (70.5 lb)

Minitower
Height: 44.76 cm (17.62 in)
Width: 17.78 cm (7.00 in)
Chassis
dimensions

Depth: 44.50 cm (17.53 in)
Converted desktop
Height: 17.78 cm (7.00 in)
Width: 44.76 cm (17.62 in)
Depth: 44.50 cm (17.53 in)
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Height: 44.45 cm (17.50 in)

Height: 44.4 cm (17.5 in)

Width: 17.15 cm (6.75 in)

Width: 20.3 cm (8.0 in)

Depth: 46.48 cm (18.30 in)

Depth: 52.5 cm (20.7 in)

Environmental specifications
Table 2-7 HP Workstation environmental specifications
Characteristic

HP Z420, 620, and 820 Workstations
Operating: 5°C to 35°C (40°F to 95°F)

Temperature

Non-operating: -40°C to 60°C (-40°F to 140°F)
NOTE:

Humidity

Altitude

Derate by 1°C (1.8°F) for every 305 m (1,000 ft) altitude over 1,524 m (5,000 ft).

Operating: 8% to 85% relative humidity, non-condensing
Non-operating: 8% to 90% relative humidity, non-condensing
Operating: 0 to 3,048 m (10,000 ft)
Non-operating: 0 to 9,144 m (30,000 ft)
Operating: ½-sine: 40g, 2-3ms
Non-operating:

Shock

●

½-sine: 160 cm/s, 2-3ms (~100g)

●

square: 422 cm/s, 20g

NOTE:

Values represent individual shock events and do not indicate repetitive shock events.

Operating Random: 0.5g (rms), 5-300 Hz
Vibration

Non-Operating: random: 2.0g (rms), 10-500 Hz
NOTE:

Values do not indicate continuous vibration.

Product specifications
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Setting up the workstation
This chapter describes how to set up your workstation.
Topics
Ensuring proper ventilation on page 14
Setup procedures on page 16
Adding monitors on page 17

Ensuring proper ventilation
Proper ventilation for the system is important for workstation operation. Follow these guidelines:
●

Operate the workstation on a sturdy, level surface.

●

Provide at least 15.24 cm (6 inches) of clearance at the front and back of the workstation.
(Workstation models vary.)
Figure 3-1 Proper workstation ventilation

●

14

Ensure that the ambient air temperature falls within the environmental specifications listed in this
document.
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NOTE: The ambient upper limit of 35 C is only good up to 1524 m (5000 ft) elevation. There is
a 1 C per 304.8 m (1000 ft) derating above 1524 m (5000 ft). So, at 3,048 m (10,000 ft), the
upper ambient air temperature limit is 30 C.
●

For cabinet installation, ensure adequate cabinet ventilation and ensure that the ambient
temperature within the cabinet does not exceed specified limits.

●

Never restrict the incoming or outgoing airflow of the workstation by blocking any vents or air
intakes as shown in the following figure.
Figure 3-2 Proper workstation placement

Ensuring proper ventilation
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Setup procedures
WARNING!
practices:

To reduce the risk of electric shock or damage to your equipment, observe these

• Plug the power cord into an AC outlet that is easily accessible.
• Disconnect power from the computer by unplugging the power cord from the AC outlet (not by
unplugging the power cord from the computer).
• Plug the cord into a grounded (earthed) three-pin outlet. Do not disable the power cord grounding
pin (for example, by attaching a two-pin adapter). The grounding pin is an important safety feature.
NOTE: An HP Z820 workstation with a 1125W power supply might require more power than the
typical office environment can supply. For details, see the Site Preparation Guide for the workstation at
http://www.hp.com/support/workstation_manuals.
To set up the workstation:
1.

Connect the mouse, keyboard, and power cord to the workstation.

2.

Connect the monitor to the workstation.

3.

Plug the workstation power cord and monitor power cord into an AC outlet.

4.

Connect other peripheral components (such as a printer) according to the instructions included
with the device.

5.

Connect an Ethernet cable to the computer and to a network router or LAN device.
Figure 3-3 Connecting the workstation
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Adding monitors
Planning for additional monitors
All graphics cards provided with HP Z series workstations support two simultaneous display monitors
(see Connecting and configuring monitors on page 21). Cards that support more than two monitors
are available. The process for adding monitors depends on your graphics card(s) and the type and
number of monitors you add.
Use this process to plan for adding more monitors.
1.

Assess your monitor needs:
●

Determine how many monitors you require.

●

Determine the kind of graphics performance you want.

●

Note the type of graphics connector used by each monitor. HP provides graphics cards with
DisplayPort (DP) and DVI interfaces, but you can use adapters and third-party cards to
interface to other graphics formats, including DVI-I, HDMI, or VGA.
TIP: Some adapters for older legacy hardware may cost more than others. You may want
to compare the cost of acquiring adapters with the cost of getting a newer monitor that
doesn't need adapters.

2.

Determine if you need additional graphics cards:
●

Consult the graphics card documentation to determine how many monitors you can connect
to the card.
You may need to acquire adapters to match the card output to the monitor connector. (See
Matching graphics cards to monitor connectors on page 19.)

●

If necessary, plan to acquire a new graphics card to drive additional monitors.

●

The maximum number of monitors that a graphics card supports depends on the card. Most
cards provide outputs for two monitors. Some provide four outputs.

Adding monitors
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NOTE: Monitors with resolutions above 1920 x 1200 pixels at 60 Hz require a graphics
card with either Dual Link DVI (DL-DVI) or DisplayPort output. To get native resolution with
DVI, however, you must use a DL-DVI cable, not standard DVI-I or DVI-D cables.
HP computers do not support all graphics cards. Make sure a new graphics card is
supported before purchasing it.See Finding supported graphics cards on page 19.
Many graphics cards provide more than two monitor outputs but limit you to using only two
at a time. Consult the graphics card documentation or look up information on the card
according to the procedure in Finding supported graphics cards on page 19.
Some graphics cards support multiple monitors by multiplexing the monitor signal across
multiple outputs. This may reduce graphics performance. Consult the graphics card
documentation or look up information on the card according to the procedure in Finding
supported graphics cards on page 19.
Make sure the card outputs match the input required by the monitors. (See Identifying monitor
connection requirements on page 20.)
The different models of Z-series workstations have different limits on the mechanical size, data
speed, and power available for additional graphics cards. In addition, the usual practical
limit for graphics cards is two per computer. Refer to the Manufacturing and Service Guide
for expansion card slot identification to make sure a new graphics card will work for your
computer.
3.

If you want to add a new graphics card or cards:
a.

Determine which HP-supported graphics card will best fit your needs in terms of number of
monitors, compatibility with the monitors you plan to use, and performance. See Finding
supported graphics cards on page 19.

b.

Make sure you have the correct drivers for the card.

c.

Install the graphic card according to the video instructions for your workstation at
http://www.hp.com/go/sml.

d.

Configure the monitor. For details, refer to Microsoft Help or to http://www.microsoft.com,
or to your Linux Help or website.
TIP: To simplify troubleshooting of possible problems, enable the monitors one at a time:
enable the first monitor and make sure it works properly before enabling the next monitor.
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Finding supported graphics cards
To find information about graphics cards supported for your workstation:
1.

Go to http://www.hp.com/go/quickspecs.

2.

In the left navigation bar under QuickSpecs, click on your country, then select Workstations.

3.

Choose your model to view the specifications.

4.

Click on the link for Technical Specifications-Graphics. This displays expanded technical
information for supported graphics cards, including how many monitors the card supports,
connectors, power consumption, drivers, and other details.

Matching graphics cards to monitor connectors
The following table describes monitor configuration scenarios.

Graphics card interface
connector
DISPLAYPORT

Monitor connector
DVI

Dual Link
DVI

DisplayPort
(DP)

HDMI

DP to DVI
adapter

DP to DL DVI
adapter

DP cable

DP to HDMI
adapter

DVI to VGA
adapter or DVII cable

DVI-D cable

DL DVI cable

N/A

N/A

No adapter
required

DVI-I cable

N/A

N/A

N/A

DMS-59 to
VGA adapter

DMS-59 to
DVI adapter

N/A

DMS-59 to DP
adapter

N/A

VGA
DisplayPort to
VGA adapter
(sold
separately)

DVI (WHITE)

VGA (BLUE)

DMS-59*

*

This interface is a dual-monitor graphics interface card that supports two VGA or two DVI monitors.

NOTE: HP graphics cards include monitor cable adapters unless otherwise indicated.
DisplayPort cards have the highest performance; VGA graphics cards have the lowest.

Adding monitors
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Identifying monitor connection requirements
The following are various scenarios for connecting monitors. (See Matching graphics cards to monitor
connectors on page 19 for more information about the different graphic cards):
●

Graphics card with DisplayPort output — If the graphics card has four DisplayPort outputs,
you can connect a monitor to each connector. Use the proper adapters if required.

●

Graphics card with DVI output — If you have a PCIe graphics card with two DVI outputs,
you can connect a monitor to each connector. Use the proper adapters if required.
NOTE: Models that have only one DVI port always have a second graphics output option
(Display Port or VGA).
Many graphics cards provide more than two monitor outputs but limit you to using only two at a
time. Consult the graphics card documentation or look up information on the card according to the
procedure in Finding supported graphics cards on page 19.
On a system with two DVI connections, port number 1 provides the primary display, which is
where the BIOS POST screen appears after a system boot. (Usually this is the lower of the two
outputs. Only one card is used during BIOS POST, although you can change this in the BIOS
settings.)

●

Graphics card with VGA and DL-DVI output — If the workstation does not have a PCIe
graphics card, but has one or more SVGA and/or DL-DVI outputs, you can connect a monitor to
each output.

●

Graphics card with DMS-59 output — If the workstation has a PCIe graphics card with a
DMS-59 output receptacle, use the appropriate adapter to connect your monitor.
Adapters are available to connect the DMS-59 output to two DVI or two VGA monitors.
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Connecting and configuring monitors
NOTE: HP-supported graphics card typically allow at least two monitors, as shown in this section;
some supported cards allow more monitors. Refer to the graphics card documentation for details.
1.

Connect the monitor cable adapters (1) (if required) to the workstation, then connect the
appropriate monitor cables to the adapters (2) or directly to the graphics card.
Figure 3-4 Connecting the cables to the workstation

2.

Connect the other ends of the graphics cables to the monitors.
Figure 3-5 Connecting cables to the monitors

3.

Connect one end of the monitor power cord to the monitor and the other end to a grounded
power outlet.

4.

Configure the monitor. For details, refer to Microsoft Help or to http://www.microsoft.com, or to
your Linux Help or website.

Adding monitors
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Using a third-party graphics configuration utility
Third-party graphics cards may include a monitor configuration utility. Upon installation, this utility is
integrated into Windows. You can select the utility and use it to configure multiple monitors with your
workstation.
Refer to your graphics card documentation for details.
NOTE: Some third-party configuration utilities require that you enable the monitors in Windows
before using the configuration tool. Refer to your graphics card documentation for more information.
NOTE: Monitor configuration utilities are also often available on the HP support website.

Customizing the monitor display (Microsoft Windows)
You can manually select or change the monitor model, refresh rates, screen resolution, color settings,
font sizes, and power management settings. To change display settings, right-click on the Windows
Desktop, then click Screen Resolution.
For more information about customizing your monitor display, refer to:
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●

Online documentation provided with the graphics controller utility

●

Documentation included with your monitor
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Converting to desktop configuration (Z420 only)
This workstation can be operated in mini-tower or desktop configuration. Follow these steps to convert
to desktop configuration:
NOTE: See a video of this task at http://www.hp.com/go/sml.
1.

Prepare the workstation for component installation.

2.

Remove the front bezel from the workstation.

3.

Press gently on the edges of the optical drive bay filler panel and remove it from the front bezel.
Figure 3-6 Removing the ODD bay filler panel

4.

Rotate the filler panel 90 degrees to a horizontal position.

5.

Align the slots in the filler panel frame with the tabs in the front bezel. Press the optical drive filler
panel back into the front bezel until it snaps into place.
Figure 3-7 Installing the ODD bay filler panel

Converting to desktop configuration (Z420 only)
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6.

On the back of the front bezel, squeeze the HP logo mounting tabs (1) and press the logo outward
(2).
Figure 3-8 Rotating the HP logo

Rotate the HP logo 90 degrees counterclockwise, then release the logo and press it back into
place.
7.

Remove the EMI filler panels and optical disk drive from the chassis.

8.

Rotate the EMI filler panels and optical drive 90 degrees, then reinstall them.
Figure 3-9 Reinstalling the optical drive

9.
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Replace the front bezel and the side access panel.
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Installing optional components
Depending on the workstation model, additional components (such as memory, hard drives, optical
drives, PCIe cards, or second processor) can be installed on your workstation.
●

To view component installation videos, go to http://www.hp.com/go/sml.

●

For installation guidelines and technical information, refer to the Maintenance and Service Guide
for your workstation at http://www.hp.com/support/workstation_manuals.

Security
Some HP workstations have a lock on the side access panel. The key for this lock is shipped attached to
the back panel of the workstation chassis.
Additional security features to reduce the risk of theft and to warn of chassis intrusion. Refer to the
Manufacturing and Service Guide at http://www.hp.com/support/workstation_manuals for
information about additional hardware and software security features available for your system.

Product recycling
HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries.
For information about recycling HP components or products, see http://www.hp.com/go/recycle.

Installing optional components
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Setting up and restoring Microsoft
Windows
This chapter provides setup and update information for the Microsoft Windows operating system. It
includes these topics:
Topics
Setting up the Microsoft operating system on page 26
Restoring the operating system with HP Recovery Manager
on page 27

NOTE: After you set up the operation system, you should make sure the latest BIOS, drivers, and
software updates are installed on the workstation. Refer to the chapter on updating the workstation.
CAUTION: Do not add optional hardware or third-party devices to the HP workstation until the
operating system is successfully installed. Adding hardware might cause errors and prevent the
operating system from installing correctly.

Setting up the Microsoft operating system
Your workstation shipped with the Microsoft Windows 7 operating system (OS). The operating system
installs when you power up the workstation for the first time. This process takes approximately 5 to 10
minutes. Carefully follow the on-screen instructions to complete the installation.
CAUTION: After installation has started, do not turn off the workstation until the process is complete.
Turning off the workstation during installation can damage the installation and operation of the
software.
For complete installation and configuration instructions, go to http://windows.microsoft.com/en-US/
windows7/help. Additional information is available in the online help tool after you successfully install
the operating system.

Installing or upgrading device drivers
You must install the appropriate device drivers before you install hardware devices. Follow the
installation instructions that came with the device. For optimum performance, your operating system
must have the most recent updates, patches, and software fixes. For additional driver and software
update information, refer to the chapter on updating the workstation.
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Transferring files and settings
The Microsoft Windows operating system offers data migration tools that help you select and transfer
files and data from one Microsoft Windows-based computer to another.
For information on these tools, go to http://www.microsoft.com.

Restoring the operating system with HP Recovery
Manager
The Microsoft Windows 7 operating system can be reinstalled using HP Recovery Manager, a tool
that reinstalls the Windows operating system and device drivers (for devices included with the system)
to a near-factory state.
If you ordered HP Recovery Manager with your workstation, the restore media is included with your
workstation components. If you did not order it, call HP support and request an HP Recovery Manager
media kit.
CAUTION: Restoring the operating system does not restore data. Before you restore the operating
system, back up your data using the method and media of your choice.
The HP Recovery Manager process deletes all information on the primary hard drive, including all
partitions.
To restore Windows 7:
1.

Boot from disc 1 of the HP Recovery Manager set.

2.

Follow the prompts to restore your operating system.

Some applications might not be restored using this process. If an application is not restored, install it
with the appropriate installation media.
NOTE: Microsoft Windows 7 also provides a backup and restore application. To learn more, go to
http://www.microsoft.com.

Restoring the operating system with HP Recovery Manager

27

5

Setting up and restoring Linux
HP offers a variety of Linux solutions for HP workstation customers:
●

HP certifies and supports Red Hat Enterprise Linux (RHEL) on HP workstations.

●

HP certifies and supports SUSE® Linux Enterprise Desktop (SLED) on HP workstations.

●

HP offers a SLED 11 preload on some Z series workstations.

This chapter describes how to set up and restore the Linux® operating system. It includes these topics:
Topics
HP Installer Kit for Linux (HPIKL) on page 29
Setting up Red Hat Enterprise Linux on page 29
Setting up SUSE Linux Enterprise Desktop (SLED) on page 31
Proprietary graphics drivers on page 32

NOTE: After you set up the operating system, make sure the latest BIOS, drivers, and software
updates are installed. Refer to the chapter on updating the workstation.
CAUTION: Do not add optional hardware or third-party devices to the workstation until the
operating system is successfully installed. Adding hardware might cause errors and prevent the
operating system from installing correctly.

HP Linux Support Matrix
Not all release streams are supported on particular platforms. To find out which streams are supported
on your workstation. refer to the Linux certification and support matrix:
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1.

Go to http://www.hp.com/linux.

2.

In the Platforms tab, select HP Workstations.

3.

Select Certification Matrix.

4.

Go to the Red Hat or SUSE tab.
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HP Installer Kit for Linux (HPIKL)
The HP Installer Kit for Linux helps users install certified versions of RHEL or SLED on HP workstations. It
is available as an operating system option on all HP workstations. The kit:
●

Contains tested drivers that augment and/or replace those found in RHEL or SLED to enable
proper use and behavior on HP workstations.

●

Does not include Linux operating system, which must be purchased separately from Red Hat or
SUSE. To view supported configurations and operating systems, go to http://www.hp.com/
support/linux_hardware_matrix.

The HPIKL option includes a FreeDOS preload. This operating system option accommodates those who
have a customized Linux distribution, or who have a licensed version of RHEL or SLED and would like to
install the HP-recommended driver additions.
The kit also can be downloaded:
1.

Go to http://www.hp.com/support/workstation_swdrivers.

2.

Select your workstation model.

3.

Select the desired operating system.

4.

Select your software/driver language, then click the Software quick jump link.

5.

Click the Obtain Software link for the appropriate package (typically the most recent revision).

6.

Click I Agree to accept the terms of the license agreement.

7.

Download the software ISO image and save it on a disk. This disk is your HP driver CD.

Setting up Red Hat Enterprise Linux
HP Z series workstations are certified and supported on RHEL streams appropriate to the hardware
technology.
●

For details of RHEL support for a particular platform, see the Hardware Support Matrix for HP
Linux Workstations at http://www.hp.com/support/linux_hardware_matrix.

●

For information about Red Hat certifications on HP workstations, go to
https://hardware.redhat.com.

HP Installer Kit for Linux (HPIKL)
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HPIKL driver CD
Recent versions of Red Hat Linux typically require only driver updates with minor fixes to support HP
workstations. These releases can usually be supported with the HPIKL driver CD, which can be used as
a post-installation utility for the standard Red Hat Linux install.
After you complete the standard Red Hat install and restart the system, a Red Hat first-boot utility runs.
After you specify a number of settings (such as the security level, time and date, root password, user
accounts), the utility lets you to load additional CDs.
The driver CD is used during this phase. All content added by HP is in the /HP directory on the CD.
You can use it to build your own image or to browse the HP content.
NOTE: Some installations may encounter problems if they are performed with a DisplayPort
connection to the monitor. This is because the default drivers that the OS installers use do not support
DisplayPort functionality. If you experience problems, try overriding the monitor choice for DisplayPort
during the start of the install and using the VESA driver instead. You can then set up the DisplayPort
monitor later.

Installing with the HP Red Hat Linux driver CD
1.

If you do not have the appropriate HP driver CD for a supported stream, create one (see HP
Installer Kit for Linux (HPIKL) on page 29.

2.

Install the operating system using the optical media included in the Red Hat Linux box-set.

3.

If you have a Red Hat driver disk for the OS version you are installing, enter linux dd on the
initial install splash screen, and then press Enter.

4.

When asked if you have a driver CD, select Yes. Place the Red Hat driver disk in the drive, and
select the appropriate drive:hd[abcd]. Continue the normal installation.

5.

After successfully installing the operating system, reboot the workstation.
●

RHEL 5: the Red Hat Setup Agent (also known as first-boot) automatically starts. At the
Additional CDs screen, insert your HP driver CD and select Install. When the driver
installation task is completed, continue following the prompts until the operating system is
successfully installed.

●

RHEL 6: Insert your HP driver CD. The HPIKL installation software automatically starts. Follow
the prompts to install the contents.

Warranty
As part of the HP workstation hardware warranty, HP provides software configuration and installation
support for certified versions of Red Hat Linux for up to 90 days from date of purchase.
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Setting up SUSE Linux Enterprise Desktop (SLED)
HP offers a 64-bit SLED 11 preload on some Z series workstations and supports 64-bit SLED 11 on
other workstations.
Various versions of SLED are certified and supported by Novell on HP workstations. For more
information, refer to the Novell certification bulletin search page at http://developer.novell.com/
yessearch.

Setting up preloaded SLED
To set up SLED on systems preloaded with the operating system:
1.

Start the workstation.

2.

When prompted, enter the workstation installation settings: password, network, graphics, time,
keyboard settings, and SUSE Customer Center Configuration.
NOTE: You can activate your SUSE subscription from the SUSE Customer Center Configuration
screen. To view the full SUSE Customer Center documentation, go to http://www.suse.com/
documentation and select your operating system.

Installing SLED with the CD Installer Kit
1.

If an HP driver CD did not come with your workstation, create one (see HP Installer Kit for Linux
(HPIKL) on page 29.

2.

Install the operating system using the CDs or DVDs included in the SUSE box-set.

3.

After successfully installing the operating system, reboot the workstation.

4.

Insert your HP driver CD. The HPIKL installation software automatically starts. Follow the prompts to
install the contents.

Warranty
HP provides configuration and installation support for SLED 11 on Z series workstations for up to 90
days from date of purchase. Novell also provides support for all versions of SLED that are certified on
HP workstations.

Setting up SUSE Linux Enterprise Desktop (SLED)
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Restoring SLED (preloaded systems only)
The SLED restore media is required to restore the Linux operating system. To create restore media:
1.

Click the SUSE ISO icon on the desktop to go to the /iso folder. This folder contains all iso images
used to preload your workstation.

2.

Follow the instructions in the readme file in this folder to copy the ISO image file onto optical
media.

3.

Store the media in a safe place. If your workstation experiences a hard drive failure, use the ISO
recovery images tor restore your operating system.

CAUTION: Restoring the operating system does not restore data. Back up your data using the
method and media of your choice.

Proprietary graphics drivers
Most HP workstations can be ordered with graphics cards that have been through extensive verification
by HP. See the Hardware Support Matrix for HP Linux Workstations at http://www.hp.com/support/
linux_hardware_matrix for a list of supported cards.
NOTE: Not all graphics cards are available on every workstation. Limitations generally occur for
cards that consume large amounts of power in lower-power workstations.
Proprietary graphics drivers supported by HP and the graphics vendors are available with the HP
Installer Kit for Linux, with the SLED 11 preload on Z series workstations, and from HP Workstation
Support at http://www.hp.com/go/workstationsupport.
These proprietary drivers are not a standard part of the RHEL or SLED distributions because they are not
open source. Driver revisions more recent than those at the HP support website are supported directly
by the vendor.
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6

Diagnostics and Minor
Troubleshooting

Calling technical support
At times you might encounter an issue that requires technical support. When you call technical support:
●

Have the computer readily accessible.

●

Write down the computer serial numbers, product numbers, model names, and model numbers
and have them in front of you.

●

Note any applicable error messages.

●

Note any add-on options.

●

Note the operating system.

●

Note any third-party hardware or software.

●

Note the details of any blinking LEDs on the front of the computer (tower and desktop
configurations) or on the side of the computer (all-in-one configurations).

●

Note the applications you were using when you encountered the problem.

NOTE: When calling in for service or support, you might be asked for the Product Number (example:
PS988AV) of the computer. If the computer has a Product Number, it is generally located next to the
10- or 12-digit Serial Number of the computer.
NOTE: On most models, the serial number and product number labels can be found on the top or
side panel and at the rear of the computer (tower and desktop configurations) or on a pull-out card on
the side of the display (all-in-one configurations).
For a listing of all worldwide technical support phone numbers, go to http://www.hp.com/support,
select your region, and click Connect with HP in the upper-right corner.

Calling technical support
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Locating ID labels
To assist in troubleshooting, product, serial, and authentication numbers are available on each
computer.
●

All workstations have a serial number (unique for each workstation) and product number. Have
these numbers available when you contact support.

●

The Certificate of Authentication (COA) is used for Windows-preinstalled systems only.

●

A Service label shows the Build ID and FeatureByte strings, which are needed for system board
replacement.

In general, these labels can be found in these locations (your computer may look different):
●

On the top, rear or bottom of the chassis (tower and desktop configuration)

●

On a pull-out card on the side of the display (all-in-one configuration)

Figure 6-1 Tower and desktop label locations

Figure 6-2 All-in-one label locations
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Locating warranty information
To locate base warranty information, see http://www.hp.com/support/warranty-lookuptool.
To locate an existing Care Pack, see http://www.hp.com/go/lookuptool.
To extend a standard product warranty, visit http://www.hp.com/hps/carepack. HP Care Pack
Services offer upgraded service levels to extend and expand a standard product warranty.

HP troubleshooting resources and tools
This section provides information on the HP Help and Support Center, E-support, and Helpful Hints for
troubleshooting.

HP Support Assistant
HP Support Assistant (Windows 7 systems only) helps you maintain workstation performance and
resolve problems. HPSA provides automated updates, onboard diagnostics, product information, and
guided assistance to help maintain optimum workstation performance. To access HPSA, click Start >
All Programs > HP Help and Support > HP Support Assistant.
NOTE: HP Support Assistant is not available on Linux.

E-support
Online access and support resources include Web-based troubleshooting tools, technical knowledge
databases, driver and patch downloads, online communities, and product change notification services.
The following Web sites are also available to you:
●

http://www.hp.com—Provides useful product information.

●

http://www.hp.com/support/workstation_manuals—Provides the latest online documentation.

●

http://www.hp.com/go/workstationsupport—Provides technical support information for
workstations.

●

http://www.hp.com/support—Provides a listing of the worldwide technical support phone
numbers. Access the telephone numbers by visiting the Web site, then select your region, and click
Contact HP in the upper-left corner.

●

http://www.hp.com/support/workstation_swdrivers—Provides access to software and drivers for
workstations.

Locating warranty information
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Troubleshooting a problem
To help you troubleshoot problems with your system, HP provides the Business Support Center (BSC).
The BSC is a portal to an extensive selection of online tools. To access BSC and troubleshoot a problem
with the workstation, complete the following:
1.

Visit http://www.hp.com/go/workstationsupport.

2.

Under the Business Support Center menu on the left, select Troubleshoot a problem.

3.

Under Select your product (center window), select Workstations (under personal
computing).

4.

Under Select your product, continue with selections as appropriate to the workstation series
and model, and to the problem you are troubleshooting.

Instant Support and Active Chat
HP Instant Support is a set of Web-based support tools that automate and speed up the resolution of
desktop computing, tape storage, and printing problems.
Active Chat enables you to electronically submit a support ticket to HP over the Web. When you submit
a support ticket, Active Chat collects information about the computer and pass it to an online support
specialist. The collection of information might take up to 30 seconds depending on the computer
configuration. When you submit a support ticket, you receive a confirmation message containing your
case ID, the support hours for your location, and the estimated time of response.
For more information about HP Instant Support and Active Chat and how to use them, go to
http://instantsupport.hp.com/.
NOTE: This feature is not available on Linux.

Customer Advisories, Customer and Security Bulletins, and Customer Notices
To find advisories, bulletins, and notices:
1.

Visit http://www.hp.com/go/workstationsupport.

2.

Select the desired product.

3.

Under Resources for <your selected product>, select See more….

4.

Under Self-Help resources: in the center of the window, choose the desired action and
appropriate information in the scroll list to view the index.

Product Change Notifications
Product Change Notifications (PCNs) are proactive notifications for product changes occurring within a
30-60 day window of the effective date of the change in the manufacturing process. PCNs give
customers advanced notice of changes to their product, such as an updated BIOS version that they may
need to qualify prior to the change taking place. The latest PCNs are located at: http://www.hp.com/
go/workstationsupport.
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Helpful hints
If you encounter a problem with the workstation, monitor, or software, the following general
suggestions might help you isolate and focus on the problem before taking further action.

At startup
●

Verify that the workstation and monitor are plugged into a working electrical outlet.

●

Remove all optical discs and USB drive keys from the drives before powering on the workstation.

●

Verify that the workstation is turned on and the power light is on.

●

If you have installed an operating system other than the factory-installed operating system, check
to be sure that it is supported on your system by visiting http://www.hp.com/go/quickspecs.

●

Verify that the monitor is turned on and the green monitor light is on.

●

Turn up the brightness and contrast controls of the monitor if the monitor is dim.

●

If the workstation has multiple video sources and only a single monitor, the monitor must be
connected to the source selected as the primary VGA adapter. During startup, the other monitor
connectors are disabled; if the monitor is connected to one of these ports, it will not function after
Power-on Self Test (POST). You can select the default VGA source in Computer Setup (F10).

During operation
●

Look for blinking LEDs on the workstation. The blinking lights are error codes that will help you
diagnose the problem. Refer to the Diagnostic lights and audible (beep) codes section in the
Maintenance and Service Guide for your workstation for information on interpreting diagnostic
lights and audible codes.

●

Press and hold any key. If the system beeps, then your keyboard is operating correctly.

●

Check all cables for loose or incorrect connections.

●

Wake the workstation by pressing any key on the keyboard or the power button. If the system
remains in suspend mode, shut down the system by pressing and holding the power button for at
least four seconds, then press the power button again to restart the system. If the system does not
shut down, unplug the power cord, wait a few seconds, then plug it in again. If it does not restart,
press the power button to start the workstation.

●

Reconfigure the workstation after installing a non–plug and play expansion board or other option.
Refer to the Hardware installation problems section of this document for instructions.

●

Be sure that all required device drivers have been installed. For example, if you have connected a
printer, you must install a printer driver.

●

If you are working on a network, plug another workstation with a different cable into the network
connection. There might be a problem with the network plug or cable.

●

If you recently added new hardware, remove the hardware and verify if the workstation functions
properly.

●

If you recently installed new software, uninstall the software and verify if the workstation functions
properly.

HP troubleshooting resources and tools
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●

If the monitor connected to a tower, desktop or all-in-one computer is blank:
◦

Plug the monitor into a different video port on the computer if one is available. Alternatively,
replace the monitor with a monitor that you know is working properly.

◦

Verify that the computer and monitor are plugged into a working electrical outlet.

◦

Verify that the monitor is turned on and the green monitor light is on.

◦

Turn up the brightness and contrast controls of the monitor if the monitor is dim.

●

If the internal display on an all-in-one computer is blank, open the computer and make sure the
graphics card is properly installed.

●

Upgrade the BIOS. A new release of the BIOS might have been released that supports new
features or fixes your problem.

●

For more detailed information, see the troubleshooting chapter in the Maintenance and Service
Guide at http://www.hp.com/support/workstation_manuals.

Customer self-repair
Under the Customer Self-Repair program, you can order a replacement part and install the part without
onsite HP technical assistance. Customer self-repair may be required for some components. See
http://www.hp.com/go/selfrepair for information on the program.
NOTE: Some components are not eligible for customer self-repair and must be returned to HP for
service. Call HP Support for further instructions before attempting to remove or repair these
components.

Other troubleshooting options
The following additional troubleshooting techniques and tools are located in the Maintenance and
Service Guide at http://www.hp.com/support/workstation_manuals:
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●

POST Error Codes

●

Diagnostic LEDs and audible beep codes

●

Troubleshooting scenarios and solutions

●

HP Vision Field Diagnostics
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Routine Care

General cleaning safety precautions
●

Never use solvents or flammable solutions to clean the computer.

●

Never immerse any component in water or cleaning solutions; apply any liquids to a clean cloth
and then use the cloth on the component.

●

Always unplug the computer before cleaning the keyboard, mouse, or air vents.

●

Always disconnect the keyboard before cleaning it.

●

Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the chassis
●

Follow the safety precautions in the Maintenance and Service Guide for your workstation before
cleaning the computer.

●

To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

●

For stronger stains, use a mild dish washing liquid diluted with water. Rinse well by wiping it with
a cloth or swab dampened with clear water.

●

For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is required because the alcohol
evaporates quickly and does not leave a residue.

●

After cleaning, always wipe the computer with a clean, lint-free cloth.

●

Occasionally, clean the air vents on the computer. Lint and other foreign matter can block the
vents and limit the airflow.

General cleaning safety precautions
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Cleaning the keyboard
CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from
under the keys.
●

If the keyboard has an on/off switch, turn it off.

●

Follow the safety precautions in the Maintenance and Service Guide for your workstation before
cleaning the computer.

●

Visible debris underneath or between the keys can be removed by vacuuming or shaking.

●

Canned, pressurized air can be used to clean debris from under the keys. Use caution because
too much air pressure can dislodge lubricants applied under the wide keys.

●

If you remove a key, use a specially designed key remover to prevent damage to the keys. This
tool is available from many electronic supply outlets.
CAUTION: Never remove a wide key (like the space bar key) from the keyboard. If these keys
are improperly removed or installed, the keyboard might not function properly.

●

Clean under a key with a swab moistened with isopropyl alcohol and squeezed out. Be careful
not to wipe away lubricants necessary for proper key functions. Allow the parts to air dry before
reassembly.

●

Use tweezers to remove any fibers or dirt in confined areas.

Cleaning the monitor
●

Follow the safety precautions in the Maintenance and Service Guide for your workstation before
cleaning the computer.

●

To clean the monitor, wipe the monitor screen with a towelette designed for cleaning monitors or a
clean cloth moistened with water.
CAUTION: Do not use sprays or aerosols directly on the screen—the liquid might seep into the
housing and damage a component.
Never use solvents or flammable liquids on the monitor because display or housing damage may
result.
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Cleaning the mouse
1.

Follow the safety precautions in the Maintenance and Service Guide for your workstation before
cleaning the computer.

2.

If the mouse has an on/off switch, turn it off.

3.

Wipe the body of the mouse with a damp cloth.

4.

If the mouse has a:
●

Laser or LED: use a cotton swab dampened with cleaning solution to gently brush out any
dust around the laser or LED, then wipe again with a dry swab. Do not wipe the laser or LED
directly with the swab.

●

Scroll wheel: spray canned, pressurized air in the gap between the scroll wheel and the click
buttons. Do not blow air directly on one spot for very long or condensation can form.

●

Roller ball: remove and clean the roller ball, remove any debris from the ball socket, wipe out
the socket with a dry cloth, and reassemble the mouse.

Cleaning the mouse

41

